
 



 



 



 

Анотація 

 
 

Тема кваліфікаційної роботи: «Цифровий DDS генератор в діапазоні 

частот 0,2Гц-10МГц». Кваліфікаційна робота бакалавра// Тернопільський 

національний технічний університет імені Івана Пулюя,  факультет прикладних 

інформаційних технологій та електроінженерії, група РАс-41. // Тернопіль,  

2021р. //с.-52, рис.-13, табл.-4, бібліог.  – 12, додат.-4. 

Ключові слова: DDS, ГЕНЕРАТОР, ПРЯМИЙ ЦИФРОВИЙ СИНТЕЗ, 

УПРАВЛІННЯ ЧЕРЕЗ ПК. 

 У дані кваліфікаційні роботі було проведено розробку цифрового DDS 

генератор в діапазоні частот 0,2Гц-10МГц. Основні техніко - експлуатаційні 

характеристики: діапазон частот 0,2Гц-10МГц; роздільна здатність 0,1Гц; 

форма сигналу: шім, пила синусоїда,меандр; живлення від шини USB. Була 

розроблена конструкторська документація, наведені розрахунки окремих 

каскадів.  
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In these qualifying works, a digital DDS generator in the frequency range 

0.2Hz-10MHz was developed. Main technical and operational characteristics: 

frequency range 0.2Hz-10MHz; 0.1 Hz resolution; signal shape: shim, sinusoidal 

saw, meander; powered by USB bus. Design documentation was developed, 

calculations of separate cascades are given. 
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Перелік скорочеь 

 

 

ШІМ – широтно-імпульсна модуляція 

ЦАП - цифро-аналоговий перетворювач 

АЧХ – амплітудно-частотна характеристика 

ФНЧ – фільтр нижніх частот 

ФВЧ – фільтр верхніх частот 

РФ – режекторний фільтр 

СФ – смуговий фільт 

ККД – коефіцієнт корисної дії 

САПР – система автоматизованого проектування і розрахунку 

ПКМ – права кнопка миші 

ЛКМ – ліва кнопка миші 

ПУЕ – правила улаштування електроустановок 
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Вступ 

 
Генераторами сигналів називають електронні пристрої які створюють 

повторювальні і неповторювальні цифрові або аналогові сигнали різної 

амплітуди і частоти. Генератори є невід’ємною річчю при налаштуванні і 

ремонті радіоапаратури. Також використовується в радіомовленні, медицині і 

радіолокації . 

Генератори сигналів бувають п’яти основних типів: генератори,які 

генерують синусоїдальні сигнали низької частоти для перевірки справності і 

ремонту динаміків, підсилювачів перетворювачів і акустичних систем; 

Генератори сигналів які генерують синусоїдальні хвилі в широкому діапазоні 

модуляції і вихідної потужності для тестування радіоприймачів, визначення 

смуги пропускання а також співвідношення сигнал/шум; Синтезатори які 

генерують сигнали довільної форми в широкому діапазоні частот; Генератори 

імпульсних сигналів; Які генерують ШІМ сигнали високої точності на точних 

частотах; А також генератори випадкового шуму які використовують при 

різних систем електронного і механічного тестування. 

Дана робота присвячена генератору з вихідним сигналом ШІМ,синусоїда, 

пилка, меандр. 
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1 Основна частина 
 

 

1.1 Аналіз технічного завдання 
 

1.1.1 Актуальність обраної теми 

З 60-х років генератори виготовлялись здебільшого трьох типів: 

- Низькочастотні RC генератори 

- Високочастотні LC генератори 

- Генератори з п'єзокерамічним резонатором 

З ерою цифрової електроніки а також вдосконалення елементної бази, були 

створенні генератори на основі цифрових методів створення сигналу. Існує 

багато типів синтезу сигналу, але основними видами їх є: 

- Синтез на основі поділу або множення частоти високо стабільного 

сигналу, з подальшою фільтрацією і очищенням; 

- Прямий синтез шляхом опитування пам'яті що зберігає відліки заданої 

форм з перетворенням з допомогою ЦАП. 

Генератори першого типу досить складні для реалізації. Для генерації 

чистого сигналу використовують системи авто налаштування частот. Даний 

метод дуже дорогий і використовується в вузьких напрямках. 

 Прямий цифровий синтез — метод, який надає отримати аналоговий 

сигнал за рахунок генерації послідовності цифрових відліків і їх перетворення в 

аналогову форму за допомогою ЦАП. Так як сигнал синтезується в цифровій 

формі, такий пристрій може забезпечити швидку зміну частоти, високу 

роздільну здатність по частотах, роботу в широкому діапазоні частот. [1]. 

Також важливою частиною є зручність використання при дослідженнях і 

налаштуваннях різних приладів. На даний момент значною перевагою 

вимірювальних пристроїв є можливість роботи з комп’ютером. Створення 

шаблонів для роботи з різним обладнанням значно пришвидшує процес в 

наладки і налаштування.  Останні моделі цифрових DDS генераторів уже мають 

таку функцію що значно полегшує користування. 
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1.1.2 Аналіз існуючих аналогів 

Розглянемо аналоги  конструкцій  генераторів які випускаються 

промислово. Головним критерієм для вибору є компактність а також 

управління генератором через комп’ютер. 
 

1.1.2.1 Генератор сигналів Voltcraft DDS-3005 

Voltcraft DDS-3005- це генератор функцій прямого цифрового синтезу 

(DDS) для генерації довільних сигналів до 5 МГц, визначених підключеним ПК 

через USB. На додаток до вільно визначаються довільних функцій, доступні 

стандартні сигнали, такі як синус, квадрат, трикутник, зуб пилки, TTL, шум, 

трапеція та експоненція, а також AM і FM. [2]. Технічні характеристики 

генератора наведені в табл. 1.1 

табл. 1.1 Технічні характеристики генератора сигналів Voltcraft DDS-3005 

Кількість каналів 1 

Форма вихідного сигналу Синус,пила,ШІМ,трикутник,TTL, 

Модуляція FM,AM 

Діапазон частот 0,1Гц-5МГц 

Роздільна здатність 0,01Гц 

Живлення Від USB 

Пам’ять 256 kpbs 

Імпеданс CH1 500 KΩ/CH2 50 Ω 

 

1.1.2.2 Генератор сигналу АНР-3616 

16-канальний генератор цифрових послідовностей забезпечує формування 

цифрових текстових послідовностей паралельно послідовного коду. Пристрій 

призначений для роботи  в автоматизованих  системах тестування і діагностики 

цифрових схем і пристроїв з використанням персонального комп’ютера. 

Використання генератора паттернів дозволяє значно скоротити час діагностики, 

тестованих або випробуваних розроблювальних пристроїв.[3]. Технічні 

характеристики генератора наведені в табл. 1.2 
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табл. 1.2 Технічні характеристики генератора сигналів АНР-3616 

Кількість каналів 16 

Форма вихідного сигналу Синус,пила,ШІМ,трикутник,TTL 

Діапазон частот 2Гц-100МГц 

Роздільна здатність 0,1Гц 

Живлення +6 В 

Пам’ять 256 kpbs 

Амплітуда вихідного сигналу 1,8...4,3 В з шагом 1,2 мВ 

 

1.1.2.3 Лабораторний генератор TEG1000-10 

Лабораторний генератор радіочастотного сигналу з вихідною потужністю 

10 дБм. Джерело може бути змінено між будь-якими двома частотами в 

заданому діапазоні з Кроком до 1 кгц. Програми включаються: LO для 

перетворення частоти, джерело сигналу для скалярних вимірювань; два або 

більше пристрої можна комбінувати для багато тонального тестування. 

Синтезоване джерело також містіть 0,5 ГБ флеш-пам'яті, яка використовується 

для встановлення файлів, Даних тесту та іншої допоміжної документації.[4]. 

Технічні характеристики генератора наведені в табл. 1.3 

табл. 1.3 Технічні характеристики генератора сигналів TEG1000-10 

Кількість каналів 1 

Форма вихідного сигналу Синус,пила,ШІМ,трикутник 

Діапазон частот 35МГц-4000МГц 

Роздільна здатність 0,1Гц 

Живлення Від USB 

Пам’ять 256 kpbs 

Амплітуда вихідного сигналу 1,8...4,3 В з шагом 1,2 мВ 

 

Як бачимо генератори промислового характеру при досягненні 

компактності зменшують характеристики пристрою. Тому є сенс в розробці 

цифрового DDS генератора. 
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1.1.3 Технічні характеристики та умови експлуатації проектованого 

виробу.  

Виходячи з пункту 1.1.2 формуємо технічне завдання для проектованого 

приладу. 

Основні параметри генератора згідно технічного завдання: 

- форма сигналу  пила, синусоїда, ШІМ; 

- діапазон частот до 10 МГц; 

Технічні вимоги на цифровий генератор складаються з експлуатаційних, 

конструктивних та електричних. 

До експлуатаційних вимог відноситься: кліматичний влив на прилад, 

напруга живлення, а також зручність в експлуатації виробу.  

Кліматичні та атмосферні характеристики в яких прилад буде працювати: 

- температура навколишнього середовища  від 25˚С до 40˚С; 

- атмосферний тиск  96…104 кПа; 

- вологість повітря при температурі 30˚С 70 % 

Враховуючи вище зазначені температурні і атмосферні умови, а також 

вологість повітря визначаємо умови експлуатації приладу. Генератор буде 

експлуатуватись в помірно-холодному кліматі в закритих приміщеннях з 

штучним регулюванням кліматичних умов.  

Вологість повітря 70 % вказує, що непотрібно захищати електричний 

монтаж лаковим покриттям, атмосферний тиск для помірно холодного клімату 

є нормальним, тому непотрібно вживати додаткових засобів захисту. 

Розроблювальний пристрій буде рідко використовуватися автономно тому 

необхідно врахувати принцип агрегатування, тобто створення закінчених 

пристроїв які входять у єдиний вимірювальний комплекс. 

Напруга живлення повинна бути уніфікованою для безпроблемного 

живлення пристрою без зовнішніх джерел живлення. 
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1.2 Аналіз структурної  і функціональної схеми цифрового DDS 

генератора 

 

 1.2.1 Проектування структурної схеми 
 

 
 

Рисунок 1.1 – Структурна схема DDS генератора 

Схему цифрового генератора можна представити у вигляді структурної 

схеми зображеної на рисунку 1.1 на якому: 

БК- блок керування пристроєм. Є програмою яка встановлюється на 

комп’ютер з операційною системою Windows і підключається до пристрою за 

допомогою порта USB. За допомогою неї можна змінювати параметри 

вихідного сигналу а також  форму і амплітуду. 

МК- модуль мікроконтролера. Приймає з порта USB команди і формує 

керуючі сигнали для цифрових резисторів згідно завантаженій на нього 

програмі. 

ЦЗР- цифрові змінні резистори. Являються матрицею резисторів в 

мікросхемі, є аналогом звичайних змінних резисторів. Керують цифровим 

генератором зміною опору на них. 

ЗГ- задавальний генератор. Створює сигнал  потрібної форми і частоти 

який задавався в програмі.  Знімається з виходу генератора на LC фільтр 

нижніх частот і надходить в буферний підсилювач. 

БП- буферний підсилювач. Являється операційним підсилювачем який 

підсилюється і надходить на  другий вихід пристрою. 
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ФМ- формувач меандру. Формує з виходу буферного підсилювача меандр 

який поступає на перший вихід пристрою. 

БЖ- блок живлення. Забезпечує живлення всіх інших блоків пристрою а 

саме блок цифрових змінних резисторів і генератора напругою 5 вольт і блок 

буферного підсилювача  напругою 9 вольт. 

 

1.2.2 Проектування принципової схеми 

Основа пристрою побудована на мікросхемі AD9834 фірми Analog Devices. 

Керуванням мікросхемою займається мікроконтролер ATtini2313 яка слугує 

містком між керуючою програмою на комп’ютері яка працює по шині USB і 

цифровим генератором яка управляється через послідовний інтерфейс SPI. 

Для забезпечення стабільності генерації сигналу  AD9834 тактується 

інтегральним кварцовим генератором частотою 50МГц. Генерований сигнал 

синусоїдної або трикутної форми проходить через диференційний пасивний 

фільтр 9-го порядку і звідти надходить на диференційний підсилювач, а після 

нього на формувач меандру і на вихід пристрою. Частота зрізу фільтра були 

вибрані в компроміс точності відтворення сигналу генератором і 

нерівномірності АЧХ і максимальної частоти сигналу. Прямокутний вихідний 

сигнал (меандр) надходять на компаратор MAX961.Після нього сигнал іде на 

додатковий вихід через буферний каскад на мікросхемі NC7SZ04. 

  Для управління амплітуди сигналу використовуються цифрові 

потенціометри, які регулюються мікроконтролером, амплітуда синусоїдального 

і трикутного сигналу регулюється шляхом зміни струму ЦАП  мікросхеми 

AD9834. Амплітуда меандру регулюється зміною наруги живлення буферного 

підсилювача. Такий спосіб керування значно зменшує рівень шумів і не 

впливає на АЧХ вихідного сигналу. 

 Живлення генератора забезпечується напругою  5 вольт з порта USB. 

Необхідне для  роботи каскадів пристрою використовується мікросхеми 

MAX1681 для забезпечення від’ємної і подвоєної напруги живлення для роботи 
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буферного і операційного підсилювача. Також для роботи логіки генератора 

використовується стабілізатор 3.3В побудований на операційному підсилювачі. 

Джерелом опорного живлення для стабілізатора слугує напруга 2.5В яка 

формується на виводі синтезатора сигналу.[5] 

Разом з пристроєм була розроблена програма для управління роботи 

генератора. Структурна схема роботи програми наведена на рисунку 1.2 

 

Рисунок 1.2 – Структурна схема програми DDS генератора 

При підключенні генератора до комп’ютера відбувається ініціалізація 

мікроконтролера: загрузка початкових значень регістрів вказівників і 

лічильників; настройка системи переривань і таймерів. З’являється спливаюче 

повідомлення у вікні програми про готовність генератора до роботи. В режимі 

очікування мікроконтролер періодично опитує програму на комп'ютері на 

наявність даних з характеристиками, формою сигналу і дозвільним пакетом  

про запуск генерації.  
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Коли генератор приймає пакет даних на екрані з'являється спливаюче 

повідомлення про старт роботи генератора. Перед запуском в регістри 

мікроконтролера генератора записуються число яке автоматично перезаписує 

регістри якщо він переповнений. Для читання кодової комбінації з пам'яті і їх 

запис а також організація нового циклу потрібно на регістр подати біт який 

знімає блокування переривань.[6] 

Читання кодової таблиці відбувається з використанням регістра вказівника 

даних. Після видачі останьої кодової комбінації регістр лічильник і регістр 

вказівник заповнюються початковими значеннями. 

Якщо на порт надходить пакет з сигналом «стоп» таймер вимикається і 

генератор переводиться в режим очікування, з'являється спливаюче вікно про 

зупинку генерації і повідомлення про готовність роботи. 

 

1.3 Розрахунок вузлів електричної принципової схеми пристрою  

 

1.3.1 Розрахунок фільтра Баттерворта 

 Електричним фільтром називається пристрій призначений для виділення з 

електричного коливання в заданих смугах частот, і подавлення складових, які 

розміщені в інших також заданих смугах частот. Вони називаються смугою 

пропускання і смугою затримки. 

 По розміщенню смуг пропускання і затримки розрізняють фільтри: нижніх 

частот (ФНЧ), смугові (СФ) і режекторні (РФ) верхніх частот(ФВЧ),. 

характеристики ідеальних фільтрів приведені на рисунку 1.3 

 

Рис.1.3 Амплітудо частотні характеристики ідеальних фільтрів 
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 Вимоги до амплітудо-частотної характеристики формують у вигляді 

вимог до залежності послаблення фільтра і формується так, щоб в смузі 

пропускання послаблення рівне нулю. Тоді послаблення фільтра в смузі 

пропускання немає перевищувати деякі задані величини. А в смузі затримки не 

повинно перевищувати значення пропускання сигналу. 

 В реальних фільтрів на відмінно від ідеальних, характеризуються також 

наявністю смуги переходу в якій послаблення фільтра не нормується і зростає 

до значень, допустимих в межах смуги пропускання, до значень потрібних 

смуги затримки фільтра. Таким чином смуга пропускання фільтра обмежується 

частотою на яких затухання фільтра не перевищує максимального затухання 

фільтра. 

 Окрім вимог до частотної залежності послаблення фільтра, які 

розглядаються як основні до його електричного конструктивних параметрів 

можуть пред’являтись додаткові вимоги, наприклад: до допустимих відхилень 

фазочастотної характеристики фільтра в його смузі пропускання від лінійної, 

що зв’язано з умовами без спотвореної передачі сигналу. В таких випадках або 

формується і вирішується відповідна апроксимаційне завдання, або з 

допомогою спеціальних кіл коректуючи фазочастотних характеристик фільтра, 

розраховано тільки по потребам до послаблення.[7] 

В генераторі  було вибрано розраховувати фільтр нижніх частот 

Баттерворта з такими вхідними характеристиками: 

Гранична смуга пропускання 10МГц 

Гранична частота смуги затримки 25МГц 

Максимальне затухання в смузі пропускання 0.15Дб 

Гарантоване затухання в смузі затримки 57.6Дб 

Опір нагрузки  600Ом 

Визначаємо потрібний порядок ФНЧ Баттерворта. 
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Де: 

maxa  - Максимальне затухання в смузі пропускання 

 mina  - Гарантоване затухання в смузі затримки 

cf  - Гранична смуга пропускання 

 cf  - Гранична частота смуги затримки 
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Визначаємо значення нормованої частоти зрізу. 

Відомо що табульований ФНЧ Баттерворта на 1c   має затухання  max 3а 

дБ. Для визначення , на якому ФНЧ Баттерворта має затухання max 0.15а  дБ, 

використовуємо вираз присвоївши змінним наступні значення: 2 3а  дБ на 2 1 

, 1 0,15a  дБ на 1 с  , 9n   
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Вирішуючи отримане рівняння відносно  отримуємо: 

0,3

0,015

1 1 10 1
lg lg 0,663

18 10 1 c
c
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Вибираємо принципову схему ФНЧ Баттерворта. Так як порядок фільтра 9- 

непарний вибираємо схему з меншою кількістю індуктивностей. Вибрана 

принципова схема показана на рисунку 2. 

 

Рис.1.4 схема ФНЧ Баттерворта 9-го порядку 
 

Визначаємо параметри нормованого ФНЧ Баттерворта 9-го порядку по 

таблиці значень елементів фільтра Баттерворта.  

Таблиця 1.4 таблиця значень елементів фільтра Баттерворта 

 

Визначаємо частотний масштабний помножувач відповідно до виразу. 
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Масштабуємо табульований нормований ФНЧ прототип по частоті 

імпедансу використовуючи вирази: 
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Виходячи з розрахунків вибираємо номінали конденсаторів: С1 та С9 по 

6.1Пф, С3 і С7 по 26,9 Пф, С5 35,1 Пф. Котушки індуктивності L2 і L7 по 

6,33мкГ, а також L4 і L6 по 11 мкГн. 

 

1.3.2 Принцип роботи перетворювача постійної напруги на комутуючих 

конденсаторах 

При конструюванні DDS генератора потрібно було без додаткових 

зовнішніх джерел живлення забезпечити +9 вольт для живлення операційного 

підсилювача а також -5 вольт для диференційного підсилювача, який потребує 

двопополярної напруги живлення ±5 вольт.  Для цього був вибраний 

перетворювач MAX1681,тому що йому не потрібно спеціальних елементів з 

точними номіналами які впливатимуть на його роботу, що здешевлює пристрій. 

Структурна схема перетворювача MAX1681 зображена на рисунку 2.19, 

функціональна схема зображена на рисунку 1.5. 

 

Рисунок 1.5 - Структурна схема мікросхеми перетворювача MAX1681 
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Перетворювач має чотири силових MOSFET ключа, що керуються 

логічними елементами і транслятором рівня напруги, робота яких здійснюється 

на частоті, яка отримана в результаті ділення на два частоти задаючого RC 

генератора. Це дозволяє формувати керуючі імпульси з необхідними 

характеристиками "меандр" і оптимізувати потрібну роботу задаючого RC 

генератора, робоча частота якого без зовнішніх елементів становить 10 кГц. 

Внутрішній регулятор напруги необхідний для забезпечення роботи 

мікросхеми від джерел з пониженою напругою. 

При замикані ключів S1 і S3 і розмиканні ключів S2 і S4 під час першої 

половини циклу зовнішній конденсатор С1 заряджається від джерела живлення 

до напруги V +, а при замикані ключів S2 і S4 і розмиканні ключів S1 і S3 під 

час другої половини циклу конденсатора С1 передає частково свій заряд 

зовнішньому конденсатору С2, що забезпечує виведення  напруги з мікросхеми. 

Але щоб забезпечити хороший коефіцієнт перетворення потрібно або 

збільшувати ємність конденсатора або збільшувати частоту. в першому випадку 

зростають габарити конденсатора і, габарити перетворювача. У другому 

випадку зростають втрати енергії в реальному пристрої, що знижує його 

коефіцієнт корисної дії. Для цього виведений зовнішній конденсатор який задає 

частоту роботи RC генератора. 

 

Рисунок 1.6 - Функціональна схема мікросхеми перетворювача MAX1681 
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Частота генерації була вибрана 500 кілогерц, згідно чого у відповідності до 

технічного опису мікросхеми був вибраний конденсатор ємністю 2.2 мкФ (С5). 

Це дозволяє забезпечити малі габарити конденсатора і непоганий ККД 

перетворювача.[8] 

 

1.4 Вибір і обґрунтування компонентної бази 
 

Компонентна база в електронному пристрої напряму впливає на надійність 

роботи пристрою. Тому слід виділити основні вимоги до параметрів 

електронних радіо елементів, а саме технічні характеристики і експлуатаційні 

параметри. 
 

Технічні характеристики: 

- номінальні значення  параметрів радіоелементів які задані згідно 

принципової схеми. 

- допустимі температурні режими елемента. 

- запас 25% робочої напруги радіо елемента  

- допустима потужність розсіювання радіоелемента. 

- діапазон робочого спектру частот  

- діапазон температур 

Експлуатація пристрою буде проходити в приміщені з температурою 

навколишнього середовища  від +15 до +40 градусів. На пристрій не буде 

взаємодіяти сильний механічний вплив. 

 

1.4.1Вибір активних елементів 
 

Транзистори 

Використовується здвоєний MOSFET  IRF7301. Перевагою вибору такого 

елемента є зменшення кількості радіоелементів, що підвищує надійність 

проектованого приладу.  
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Основні параметри: 

тип Здвоєний MOSFET; 

вихідна потужність 2Вт; 

напруга живлення 20В; 

вихідний струм 5A; 

опір відкритого переходу 0.16Ом; 

робоча температура -40°...+150°С; 
 

Діоди 

Використовується  малопотужний кремнієвий діод 1N4001FL. Велика 

поширеність а також низька вартість елемента є ідеальним варіантом для 

роботи в генераторі. 
 

Основні параметри: 

Максимальний прямий струм 0.2 А; 

Максимальний зворотній струм 5 мкА; 

Максимальна пряма напруга 1 В; 

Загальна ємність 4 пФ; 

Робоча температура  -65...50 °C; 
 

Мікросхеми 

Основним вузлом є мікросхема  AD9834. Саме ця мікросхема генерує усі 

сигнали: пилкоподібні, синусоїда, ШІМ модуляція. Побудована в корпусі 

SOP20 компанії «Texas Instruments» може генерувати сигнал синусоїди з 

похибкою 0,1% на гармоніку також генерує ШІМ сигнал з великою амплітудою 

і малим затуханням і особливістю цієї мікросхеми є генерація з плаваючою 

точкою.  
 

Основні параметри: 

Живлення В +2.3...+5.5; 

Швидкість МГц 50; 
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Енергоспоживання мВт 20; 

Генерація синусоїди мГц 0,01...50; 

Генерація пили мГц 0,02...30; 

Генерація прямокутних імпульсів мГц 0,02...40; 
 

Мікроконтролер ATtini2313 був вибраний через дешевизну, виконує всі 

обчислення і виміри в пристрої, складається з 20 виводів в корпусі SOP20 

являється економічним вибором мікроконтролера у співвідношенні ціна/якість 

має в собі усі функції ATmega 8 але з меншою кількістю можливостей.  
 

Основні параметри: 

Робоча напруга В 1,8...5,5; 

Струм споживання, мА 20; 

Потужність розсіювання, мВт 50; 

Смуга пропускання, МГц 35; 

Швидкість наростання, В/мкс 0,01; 

Кількість підсилювачів 1; 

Робоча температура,С -40...+85; 
 

Електронний потенціометр має використовується для електронного регулювання 

амплітудою сигналу, через малі габаритні розміри зручно використовувати у 

портативних пристроях. 
 

Основні параметри: 

Вихідна напруга, В 0,2...5; 

Максимальна вхідна напруга, В 12; 

Максимальний вихідний струм, А 0,1; 

Максимальна потужність розсіювання, Вт 0,2; 

Коефіцієнт згладжування пульсацій, дБ 25; 

Струм споживання, мА 1; 

Дрейф напруги, % 1; 
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Коефіцієнт нестабільності по напрузі, %/В 0,05; 

Температурний коефіцієнт напруги, %/С 6,02; 

Робоча температура, С -40 , +85; 
 

Для підвищення потужності вихідного сигналу використовується MAX961 

перевагою цієї мікросхеми є малий струм споживання також малий коефіцієнт шумів 

на максимальній потужності. 
 

Основні параметри: 

Тип виходу Комплементарний; 

Діапазон напруги живлення 2,7 В…5,5 В; 

Струм живлення 11 мА; 

Час розповсюдження сигналу Вх-Вих 4,5 нС; 

Діапазон робочих температур -40…+85; 
 

Для керування виходом меандру використовується мікросхема NC7SZ04M5X, її 

перевагою є низьке електроспоживання, а також низьке спотворення сигналів. 
 

Основні параметри: 

Номінальний струм 20 мА; 

Номінальна напруга 1,6 В…5,5 В; 

Максимальний вхідний струм 32 А; 

Максимальний вихідний струм 5 А; 

Робоча температура -5…+125; 
 

Для підвищення потужності сигналу з цифрових потенціометрів а також для 

стабілізатора напруги 3,3 В використовується мікросхема LM324 Перевагою цієї 

мікросхеми є малі розміри при великій вихідній потужності. 
 

Основні параметри: 

Кількість каналів ОУ 4; 

Напруга живлення 3 В…32 В; 
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Струм споживання 2 мА; 

Частота підсилювання 1,2 МГц; 

Рівень шумів 32 нВ/Гц; 
 

Для хорошого кінцевого перетворення і підсилення цифрового сигналу 

використовуються диференційний підсилювач AD8130. Перевагою цієї мікросхеми є 

якісний аналоговий вихідний сигнал з малим спотворенням 

 

 Основні параметри: 

Тип Диференційний підсилювач; 

Напруга живлення 4.5 В…25 В; 

Струм споживання 13 мА; 

Максимальна швидкість наростання сигналу 1100 В/мкс; 

Діапазон робочих температур -40…+85; 
 

Світлодіод 

Для індикації роботи пристрою використовується LED світло діод 3.5 мм HL1 

типу FYL-3004GD Даний  індикатор добре підходить до пристрою, хороша 

інтенсивність свічення  і великий кут розсіювання дає можливість побачити роботу 

навіть при сильному зовнішньому освітленні 
 

Основні параметри: 

Довжина хвилі 570 нм; 

Яскравість 15 мКд; 

Робоча напруга 2,2...2,5 В; 

Робочий струм 30 мА; 

кут світіння° 60°; 

Робоча температура -40...60°C; 
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1.4.2 Вибір пасивних  елементів 
 

Резистори 

Під час вибору елементної бази для проектованого виробу оптимальним 

варіантом вибору постійних резисторів R1-R13, R15-R23, R25-R34  типу 0603 

виробник фірми «Royal OHM» з потужністю 0,1Вт. Вони мають дуже високу 

стабільність параметрів, малу залежність опору від температури, частоти, 

напруги, малі габарити і високу надійність. Призначені для роботи в електрич-

них колах постійного, змінного та імпульсного струмів, ці резистори досить 

часто використовуються тому їх дістати буде не важко,  вони мають хороші 

параметри, також даний тип резисторів є не дорогим, що значно зменшує 

вартість виробу  
 

Основні параметри: 

Номінальна потужність, Вт 0,1; 

Діапазон номінальних опорів, Ом 1—10-106; 

Допустиме відхилення опору, % ±10; 

Максимальна робоча напруга, В 50; 

Діапазон робочих температур, °С  -60...+155. 
 

Кращим варіантом при виборі підстроювального резисторів які будуть 

використовуватися для підстроювання електричних параметрів, був вибраний 

резистор типу  3296W виробник фірми «Royal OHM»,. Був обраний такий тип 

резистора через поширеність в продажі, хорошу якість виконання та не високу 

ціну  
 

Основні параметри: 

Тип провідника металокераміка; 

Номінальний опір кОм 15; 

Точність, % 10; 

Номінальна потужність, Вт 0,75; 
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Максимальна робоча напруга,  В 1000; 

Робоча температура, С -55...+125; 

Кількість оборотів  15. 
 

Конденсатори 

Конденсатори C1-C40 типу 1206 виробники фірми «SAMSUNG» - 

керамічні багатошарові. Вони мають малі габарити, являються дуже дешевими 

та доступними. Призначені для роботи в ланках постійного та пульсуючого 

струмів, а також в імпульсних режимах. Використовуючи конденсатори такого 

типу дає нам можливість автоматизувати процес виготовлення виробу  
 

Основні параметри: 

Робоча напруга, В 50; 

Відхилення ємності від номінального значення, % 5; 

Інтервал робочих температур, °С -55...+125; 

Температурний коефіцієнт ємності ПСЕ+3,3; 

Відносна вологість, % до 98; 

Діапазон тиску, гПа 6,6-2942; 

Діапазони ємностей 1пФ — 10мкФ 
 

Котушки індуктивності 

Для перетворення цифрового сигналу з цифрового генератора в аналоговий 

використовується котушка індуктивності MCFE1608TR47MG перевагою є великі 

номінали індуктивності при малих розмірах  
 

Основні параметри: 

Номінальний струм 200 мА; 

Номінальна напруга 20 В; 

Робоча температура -5…+125; 

Діапазон Індуктивностей 1...30 мкГ; 
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Для запобігання високочастотних завад у схемі, використовується фільтр 

продавлення BLE21AG102SN1 перевагою цього компонента є хороше продавлення 

високочастотних завад що покращує вихідні параметри генератора.  
 

Основні параметри: 

Смуга подавлення завад  від 1 до 10МГц; 

Імпеданс 100 МГц 1 кОм; 

Номінальний струм 200 мА; 

Номінальна напруга 20 В; 

Робоча температура -5…+125; 
 

Роз’єми  

Для  підключення проводів до виходу використовується  BNC конектор (J2,J4). 

Хороший цей розє’м тим що він дає завадо захищеність сигналу і є зручним для 

швидкого використання генератора. 
 

Основні параметри: 

Хвилевий опір 50 Ом; 

Робоча напруга 500 В; 

Діапазон частот 5 Гц…5 ГГц; 

Робоча температура -40…+125; 
 

Для живлення плати використовується USB роз’єм. Перевагою є те що цей тип 

роз’ємну дуже поширений і не потрібно укомплектовувати прилад кабелем, також при 

несправності шнура можна легко його замінити 

 

Основні параметри: 

Діапазон напруги живлення 2,7 В…5,5 В; 

Струм живлення 11 мА; 

Діапазон частот 200 МГц; 

Діапазон робочих температур -40…+85; 
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Кварцові резонатори 

Для задавання опорної генерації мікросхемі генератора, використовується 

генератор ZQ2 типу KXO-V97 фірми CEYER . Даний генератор має хороші 

частотні характеристики і є досить компактний для інтеграції в пристрій. 
 

Основні параметри: 

Напруга живлення 5В; 

Струм споживання 50мА 

Частота  генерації 50Мгц 

Робоча температура  -40...+60°C 
 

  Для задавання частоти генерації мікроконтролера був використаний 

кварцовий резонатор ZQ1 типу HC-49S фірми CEYER. Даний генератор має 

непогані характеристики і малі габарити 

 

Основні параметри: 

Напруга живлення 5В; 

Струм споживання 50мА 

Частота  резонації 12Мгц 

Загрузочна ємність 32 пФ 

Робоча температура  -40...+60°C 

 

1.5 Компоновка друкованого вузла цифрового DDS генератора 

 

При компонуванні друкованого вузла слід враховувати теплові режими 

радіоелементів, параметри надійності, ергономіку розміщення елементів 

настройки для зручного користування приладом. 

Форма приладу найбільше визначається такими факторами: 

- вимоги лаконічності форми, що вимагається необхідністю застосування 

уніфікованих і стандартних виробів; 
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- склад і форма комплектуючих радіоелементів; 

- відповідність приладу стандартним ергономічним та естетичним 

вимогам, що диктуються модою і напрямком де використовується прилад; 

 Також не менш важливим є компоновка самого друкованого вузла, тому 

слід врахувати такі конструктивні вимоги до компоновки: 

- між окремими вузлами,блоками повинні бути відсутні паразитні 

електричні і електромагнітні зв’язки; 

- необхідно забезпечити легкий доступ до вузлів налаштування приладу; 

- тепло яке виділятиметься під час роботи пристрою не повинне 

погіршувати технічні характеристики апарату; 

Також важливою частиною в компонуванні пристрою є зменшення 

паразитних зв'язків. Вони бувають електромагнітні, електростатичні і 

кондуктивні. 

Електромагнітні зв'язки виникають при протіканні струму через 

індуктивності і провідники електростатичні створюються через різницю 

потенціалів між точками корпусу або паразитні ємності. Кондуктивні 

виникають коли загальне навантаження є спільним для декількох електричних 

вузлів. 

Для усунення паразитних зв'язків здебільшого достатньо лише 

раціонального розміщення елементів на друкованій платі. Однак деколи цього 

не достатньо. Для вирішення такої проблеми використовують розділення схеми 

на функціональні каскади, зменшення довжини друкованих провідників, якщо 

елемент чутливий до паразитного зв'язку необхідно щоб даний елемент мав 

лише одне з'єднання з шиною заземлення. 

Виходячи з рекомендацій по використовується така компоновка: 

- мікросхема синтезатора і фільтр який відновлює сигнал в аналогову 

форму, мають бути максимально близько один до одного; 

- диференційний підсилювач має бути як найближче до вихідних клем 

генератора; 
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- клеми а також роз’єм джерела живлення розмістити максимально далеко 

один від одного, для запобігання паразитних зв'язків; 

 - підстроювальні резистори розмістити на краю плати і зробити легкий 

доступ для налаштування пристрою; 

- перетворювачі напруги розмістити подальше від блоків які генерують 

сигнал. 

- встановити завадогасячі індуктивності біля перетворювачів напруг а 

також біля мікроконтролера і синтезатора сигналу.  

 

1.5.1 Обґрунтування та метод виготовлення друкованої плати. 

Друковані плати класифікуються на: односторонні, двохсторнонні та 

багатошарові. 

В даному проектованому виробі використовується двохстороння 

друкована плата з металізацією перехідних отворів. Такий метод виготовлення 

друкованої плати зменшує загальну площу друкованої плати а також значно 

зменшує довжину доріжки, що покращує  вихідні характеристики пристрою.  

 Для виготовлення плат був вибраний третій клас точності. Даний клас 

забезпечує високу щільність трасування друкованих провідників а також при 

використанні поверхневого монтажу радіоелементів збільшується 

технологічність конструкції. 

Через вибір 3-го класу точності друкованої плати обираєм для 

виготовлення плати комбінований метод. Даний метод є більш складніший і 

потребує додаткової апаратури для виготовлення, але він забезпечує високу 

якість друкованих провідників. 

Матеріал друкованої плати визначається від електричних і фізико-механічних 

факторів. Також враховується механічні і кліматичні впливи які впливатимуть 

на плату. 

  Товщина друкованої плати вибирається від механічної міцності і 

жорсткості. Найпоширенішим матеріалом на виробництво є двохсторонній 
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фольгований склотекстоліт. Не менш важливою характеристикою є також 

товщинна друкованої плати, зазвичай використовується текстоліт 1,5мм.[9] 

 Враховуючи вище зазначенні вимоги до друкованої плати обираєм  

фольгований склотекстоліт марки СФ-2-35-1,5мм, тобто двохсторонній 

склотекстоліт з товщиною міді 35мкм і товщиною текстоліту 1,5мм. 

 

1.5.2 Розрахунок друкованого монтажу 

Визначаємо мінімальну довжину друкованого провідника по постійному 

струмі: 
 

𝑏 =
доп∙

 (1.7) 

 

де Imax – максимальний струм який буде протікати через провідник. 

 З аналізу принципової схеми було визначено, Imax = 0,2A; 

iдоп = 75А/мм2 – густина струму для виготовлення плати комбінованим 

методом; 

t = 20мкм = 0,02м – товщина доріжки. 
 

𝑏 =
0,2

75 ∙ 0,02
= 0,13мм 

 

визначаємо ширину провідника : 
 

𝑏 =
∙ ∙

доп∙
 (1.8) 

 

де  ρ – питомий об’ємний опір. ρ = 0,0175Ом*мм2/м; 

l – довжина провідника. l = 0,3м; 

Uдоп – допустиме падіння напруги на провіднику, з схеми було визначено. 

Uдоп = 0,45В.  

 

𝑏 =
0,0175 ∙ 0,2 ∙ 0,3

0,45 ∙ 0,02
= 0,12мм 
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Визначаємо діаметр монтажних отворів, d: 
 

𝑑 = 𝑑 + |∆𝑑н.в.| + 𝑟 (1.9) 
 

де  de – максимальний діаметр виводу радіоелемента; 

∆dн.в. – граничне відхилення від номінального діаметру (0,1 для всіх); 

r – різниця між мінімальним діаметром отвору і максимальним діаметром, 

вибирають в межах 0,1…0,4мм. Значення зводять до стандартних діаметрів 

de1 = 0,7 переходів між платами. 

de2=0,9 для роз’єму.  

 

𝑑 = 0,7 + |0,1| + 0,1 = 0,9мм 

𝑑 = 0,9 + |0,1| + 0,1 = 1,1мм 
 

Приймаємо такі стандартні значення: 0,9мм; 1,1мм. 

Розраховуємо діаметр контактних площадок:  

 

𝐷 = 𝐷 + 1,5ℎф (1.10) 

 

де  hф – товщина фольги; 

D1min – мінімальний ефективний діаметр площадки.  

 

𝐷 = 2(𝑏 + + 𝛿𝑑 + 𝛿𝑝) (1.11) 

 

де bм – відстань від краю просвердленого отвору до краю контактної 

площадки; bм = 0,06мм. 

δd і δp – допуски на розташування отворів і контактних площадок; δd = 

0,25мм; δp = 0,4мм. 

dmax – максимальний діаметр просвердленого отвору, мм. 

𝑑 = 𝑑 + ∆𝑑 + (0,1…0,15) (1.12) 

де ∆d –  допуск на отвір.  
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𝑑 = 0,9 + 0,1 + 0,1 = 1,1мм 

𝑑 = 1,1 + 0,1 + 0,1 = 1,3мм 

𝐷 = 2 0,06 +
1,1

2
+ 0,25 + 0,4 = 2,52мм 

𝐷 = 2 0,06 +
1,3

2
+ 0,25 + 0,4 = 2,72мм 

𝐷 = 2,52 + 1,5 ∙ 0,02 = 2,55мм 

𝐷 = 2,72 + 1,5 ∙ 0,02 = 2,75мм 
 

Максимальний діаметр контактної площадки:  

 

𝐷 = 𝐷 + (0,2…0,6) (1.13) 

𝐷 = 2,55 + 0,2 = 2,75мм 

𝐷 = 2,75 + 0,2 = 2,95мм 
 

Визначаємо ширину провідників.:  

 

𝑏 = 𝑏 + 1,5ℎф (1.14) 

 

де b1min – мінімальна ефективна ширина провідника, мм. b1min = 0,18мм для 

плат 3-го класу точності.  

 

𝑏 = 0,18 + 1,5 ∙ 0,02 = 0,21мм 
 

Визначаємо мінімальну відстань між елементами провідного матеріалу. 

Мінімальна відстань між провідником і контактною площадкою:  

 

𝑆 = 𝐿 − [ + 𝛿𝑝 + + 𝛿1 ] (1.15) 

 

де L0 – відстань між центрами відповідних елементів.  

 

𝑆 = 2,5 −
2,75

2
+ 0,4 +

1,1

2
+ 0,1 = 0,08мм 
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Мінімальна відстань між двома контактними площадками:  

 

𝑆 = 𝐿 − (𝑑 + 2𝛿𝑝)  (1.16) 

𝑆 = 2,5 − (1,1 + 2 ∙ 0,4) = 0,6мм 

𝑆 = 2,5 − (1,3 + 2 ∙ 0,4) = 0,4мм 
 

Мінімальна відстань між двома провідниками:  

 

𝑆 = 𝐿 − (𝑑 + 2𝛿𝑑)  (1.17) 

𝑆 = 2,5 − (1,1 + 2 ∙ 0,2) = 1мм 

𝑆 = 2,5 − (1,3 + 2 ∙ 0,2) = 0,8мм 
 

При розрахунку мінімальної ширини друкованого провідника, в результаті 

обрахунків ширина друкованого провідника дорівнює 0,13мм. 

При розрахунку діаметрів монтажних отворів, розраховані значення були 

зведені до нормалізованого ряду отворів: 0,9мм; 1,1мм. 

Максимальний діаметр контактних площадок: 

Для монтажних отворів 0,6мм становить 2,75мм. 

Для монтажних отворів 1,1мм становить 2,95мм. 

Мінімальна відстань між провідником і контактною площадкою під час 

розрахунку становить: 0,08мм і 0,13 мм. 

Мінімальна відстань між двома контактними площадками під час 

розрахунку становить: 0,6мм та 0,4мм. 

Мінімальна відстань між двома провідниками під час розрахунку 

становить: 1мм та 0,8мм. 

Оскільки деякі розраховані значення вийшли від’ємними, то контактні 

площадки будуть мати нестандартну форму, а провідники будуть із звуженням. 

В зв’язку із точністю плати відстань провідників між провідниками і 

контактними площадками вибираємо 0.4 і 0.4 відповідно. [10] 
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2 Спеціальна частина 

 
 

2.1 Вибір і обґрунтування задачі автоматизованого проектування 

 

Для розробки друкованого вузла було використано САПР систему Altium 

Designer. За допомогою цієї програми було створено друковану плату. 

При проектуванні друкованого вузла важливою складовою для надійної 

роботи пристрою є якість розведення друкованих провідників на платі, 

провідники шин, цифрових передач даних, які повинні бути рівні за довжиною. 

Провідники на яких передбачається протікання великих струмів, повинні мати 

більшу площу провідника. Ті та інші задачі виконує наполовину автоматизовано 

Altium Designer, що значно пришвидшує процес проектування друкованої плати 

і забезпечує меншу кількість помилок спровокованих людським фактором. 

Перевагами Altium Designer є: 

- гнучкість  програмних функцій, які налаштовуються індивідуально для 

конкретного користувача; 

- можливість роботи з файлами які були створені в більш ранній версії цієї 

програми; 

- виконання широкого кола задач. 

- можливість переглядати 3D вигляд друкованого вузла 

 

2.2 Опис реалізації даної задачі в системі автоматизованого проектування 

 

2.2.1 Створення проекту 

 Відкриваємо Altium Designer, створюємо новий проект друкованої плати: 

File→New→Project→PCB Project. Зберігаємо проект в створеній для нього 

папці, для чого наводим вказівник миші на ярлик проекту у вікні панелі Project 
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(за замовчуванням розташовується в лівій частині екрану),натискаємо праву 

кнопку миші і у контекстному меню вибираємо команду Save Project. Також 

зберегти проект можна через меню File. 
 

2.2.2 Додавання до проекту документу схеми електричної принципової 

У вікні панелі Projects виділяєм  ярлик проекту ПКМ і вибираємо у 

контекстному меню Add New to Project→Schematic. Після цього в  дереві 

проекту повинен з'явитись ярлик документу електричної принципової схеми і з 

розширенням *.SchDoc. Далі необхідно зберегти файл схеми в папці проекту. 

Це можна зробити через контекстне  меню (виділити ярлик документу ПКМ в 

дереві проект і вибрати Save) або через меню File (див .рис.2.1) 

 

Рисунок 2.1 – Додавання до проекту документу схеми електричної 

принципової 
 

2.2.3 Вибір одиниць вимірювання для схеми електричної принципової 

Натискаємо праву кнопку миші всередині робочої області документа, і в 

контекстному меню вибрати Options→Document Options. У вікні властивостей 

документу, що з'явиться, вибрати вкладку Units (одиниці вимірювання) і 

переконатись, що вибрані метричні одиниці(див .рис.2.2) 
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Рисунок 2.2 – Встановлення метричних одиниць вимірювання для 

документу електричної схеми 
 

2.2.4 Встановлення параметрів аркушу 

Параметри аркушу документу електричної принципової схеми 

встановлюються на вкладці Sheet Options вікна Document Options (див .рис.2.3) 

 

Рисунок 2.3 – Вкладка настроювання параметрів аркушу у вікні 

властивостей документу електричної схеми 
 

2.2.5 Вибір бібліотеки УГП.  
 

Викликати вікно панелі Libraries, що за замовчуванням розташовується в 

правій частині екрану. Із списку встановлених бібліотек вибрати необхідну 

бібліотеку. Нижче від списку з переліком бібліотек на панелі Libraries 

розташовується вікно пошуку, перелік компонентів бібліотеки, зображення 

символів компонентів,список моделей,зображення посадочного місця. 
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Щоб бібліотеку можна було використовувати, її необхідно інсталювати,або 

додати до проекту. Інстальовані бібліотеки доступні для усіх проектів. При 

додаванні бібліотеки до проекту вона буде доступна лише для цього проекту. 

Для інсталяції або додавання бібліотеки необхідно відкрити вікно Available 

Libraries (доступні бібліотеки), натиснувши кнопку Libraries на панелі Libraries. 

Це вікно має три вкладки:Project, Installed, SearchPath. (див .рис.2.4) 

 

 

Рисунок 2.4– Вікно панелі Libraries 

 

2.2.6 Розміщення компонентів з бібліотеки на робочому полі схеми.  

Для розміщення на схемі треба вибрати ЛКМ ім’я компонента у списку 

Component Name панелі Libraries, утримуючи натиснутою ліву кнопку миші, і 

пересунути зображення компонента в робочу область документа електричної 

принципової схеми. Також розмістити компонент на схемі можна натиснувши 

кнопку Place у верхній частині панелі Libraries. Ще один спосіб пошуку та 



 

 
Змн. Арк. № докум. Підпис Дата 

Арк. 

42 ГБВ 3.119.001 ПЗ 

розміщення компонента - використати команду Part. в меню Place. Розміщення 

УГП відбувається з прив'язкою до координатної сітки. 

 Крок координатної сітки вибирається послідовним натисканням клавіші G 

на клавіатурі, при цьому встановлене на даний момент значення кроку сітки та 

координати курсору відображаються в лівому нижньому куті вікна програми.  

Електричні зв'язки між елементами встановлюються командою PlaceWire. 

Цей інструмент можна викликати кількома способами: 

1-й спосіб: натиснути кнопку  на панелі інструментів Wiring (при 

наведенні вказівника миші на кнопки через деякий час з'являється підказка); 

2-й спосіб:натиснути ПКМ на вільному місці робочої області і в 

контекстному меню вибрати Place→Wire; 

3-й спосіб: скористатись клавіатурним скороченням, послідовно 

натиснувши клавіші P та W. 

2.2.7 Послідовність дій при проведенні ліній електричного зв'язку 

Натискання клавіші пробілу Space при проведенні лінії електричного 

зв'язку змінює варіанти розташування проміжних зламів лінії. Для нумерації 

елементів схеми необхідно вибрати команду Tools→Annotate Schematics,при 

цьому з'явиться вікно Annotate, в якому встановлюються параметри нумерації. 

група Schematic Annotation Configuration (конфігурація позначень елементів): 

Група опцій Orderof Processing (порядок обробки) дозволяє вибрати 

порядок нумерації елементів з випадаючого списку. При цьому вибраний спосіб 

ілюструється рисунком з низу списку. 

Група опцій Matching Options (опції збігу) дозволяє відмітити параметри за 

якими ідентифікуються компоненти, що повинні фізично знаходитись в одному 

корпусі(див .рис.2.5). 
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Рисунок 2.5 – Вікно Annotate для автоматизованого встановлення 

позиційних позначень 
 

Для перевірки правильності (коректності) змін необхідно натиснути 

кнопку Validate Changes (перевірити зміни). Після перевірки в кожному рядку в 

стовпці Check з'явиться значок результату  перевірки, який при відсутності 

помилок повинен мати зелений колір. Останнім кроком в процесі модифікації 

позиційних позначень є оновлення позиційних позначень в схемі, тобто 

виконання запиту на внесення змін. Для цього необхідно натиснути кнопку 

Execute Changes (виконання змін). Після цього зелена відмітка успішного 

виконання операції для усіх модифікованих позиційних позначень з'являється в 

стовпці Done (завершено). Якщо при перевірці виявлено помилку при зміні 

позиційного позначення, в рядку Messages навпроти відповідного елемента 

з'являється повідомлення(див .рис.2.6). 
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Рисунок 2.6– Вікно запиту на внесення змін щодо позиційних позначень 

елементів 

2.2.8 Загальна послідовність дій для зміни позиційних позначень при 

автоматичній нумерації елементів: 

Вибрати пункт Annotate Schematic в меню Tools, при цьому відкриється 

вікно Annotate 

Вибрати бажаний порядок нумерації та опції нумерації в групі Schematic 

Annotation Configuration вікна Annotate та в списку із запропонованими змінами 

(при необхідності) 

Натиснути кнопку Update Change List для оновлення інформації в списку 

запропонованих змін 

Натисну ти кнопку Accept Changes (Create ECO) для переходу до вікна 

запиту на зміну параметрів Engineering Change Order із остаточним списком 

змін позиційних позначень елементів 

У вікні Engineering Change Order при необхідності зняти відмітку Modify 

для елементів, до яких непотрібно змінювати позиційне позначення 

Натиснути кнопку Validate Changes для перевірки змін 

Натиснути кнопку Execute Changes для застосування змін. 

Закрити вікна Engineering Change Orderта Annotate кнопкою Close 

Для зміни позиційних позначень без зміни налаштувань необхідно вибрати 

команду Annotate Schematics Quietly. При цьому не відкривається вікно 
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Annotate і зміна позиційних позначень  здійснюється автоматично із 

застосуванням встановлених минулого разу налаштувань. 

Для скидання позиційних позначень необхідно вибрати команду 

Tools→Reset Schematic Designators Для скидання однакових позиційних 

позначень в схемі необхідно вибрати команду Tools→Reset Duplicate Schematic 

Designators. 

Результатом роботи є схема USB DDS Генератора(див .рис.2.7) 

 

Рисунок 2.7–Схема USB DDS Генератора 
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3 Безпека життєдіяльності, основи охорони праці 

 

 

3.1 Вимоги пожежної безпеки до електроустановок при роботі 

 

При розробці та налаштуванні електрообладнання, використовуючи 

вимірювальну апаратуру, щоб унеможливити виникнення пожежі кожна 

складова систем електроустановок потребує уваги з позиції дотримання правил 

пожежної безпеки 

Роботодавець (власник) підприємства зобов’язаний забезпечити 

обслуговування та технічну експлуатацію електроустановок. Особа, призначена 

відповідальною за їхній протипожежний стан (головний енергетик, енергетик, 

інженерно-технічний працівник відповідної кваліфікації), зобов’язана: 

- організовувати та проводити профілактичні огляди та планово-

попереджувальні ремонти електрообладнання й електромереж, а також 

своєчасне усунення порушень, які можуть призвести до пожежі; 

- забезпечувати правильність застосування електрообладнання, кабелів, 

електропроводок залежно від класу пожежо- та вибухонебезпечності зон і умов 

навколишнього середовища, а також справний стан апаратів захисту від 

коротких замикань, перевантажень та інших небезпечних режимів робіт; 

- організовувати навчання та інструктажі чергового персоналу з питань 

пожежної безпеки під час експлуатації електроустановок. 

У разі неможливості технічного обслуговування електроустановок силами 

персоналу підприємства його власник повинен укласти договір на планове 

технічне обслуговування зі спеціалізованою організацією. 

Загальні вимоги: 

- усе електрообладнання (корпуси електричних машин, трансформаторів, 

апаратів, світильників, розподільчих щитів, щитів управління, металеві корпуси 

пересувних і переносних електроприймачів) підлягає зануленню або 
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заземленню відповідно до вимог розділів Правил улаштування 

електроустаново. 

- на підприємстві слід встановити порядок відключення напруги з 

електрообладнання, силових та контрольних кабелів на випадок пожежі. При 

цьому електроживлення систем пожежної автоматики, протипожежного 

водопостачання та експлуатаційного (аварійного) освітлення не повинно 

відключатися. 

- в усіх приміщеннях, які після закінчення роботи замикаються і не 

контролюються черговим персоналом, з усіх електроустановок та 

електроприладів, а також з мереж їхнього живлення повинна бути відключена 

напруга (за винятком чергового освітлення, протипожежних та охоронних 

установок, а також електроустановок, які за вимогами технології працюють 

цілодобово). При цьому в будівлях усі електроустановки, які працюють 

цілодобово, повинні бути заживлені самостійними лініями, починаючи від 

увідного пристрою в будівлю. Кожна така електроустановка повинна мати свій 

апарат захисту (запобіжник або автоматичний вимикач). Вимкнення 

електропостачання повинно виконуватися від одного загального вимикача, до 

якого є вільний доступ електротехнічному персоналу та який розміщений біля 

виходу з будівлі. 

- електроприлади та апаратура повинні вмикатися в електромережу тільки 

за допомогою справних штепсельних з’єднань та електророзеток заводського 

виготовлення. 

- електричні машини, апарати, обладнання (апарати управління, пуско-

регулювання, контрольно-вимірювальні прилади, електродвигуни, 

світильники), електропроводи та кабелі за виконанням та ступенем захисту 

повинні відповідати класу зони згідно з ПУЕ, мати апаратуру захисту від 

струмів короткого замикання та інших аварійних режимів. 

- плавкі вставки запобіжників повинні бути калібровані із зазначенням на 

клеймі номінального струму вставки (клеймо ставиться заводом). 
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- температура зовнішньої поверхні електро-опалювальних приладів у 

найбільш нагрітому місці в нормальному режимі роботи не повинна 

перевищувати 85 °С. 

- несправності в електромережах та електроапаратурі, які можуть 

викликати іскріння, коротке замикання, понаднормовий нагрів горючої ізоляції 

кабелів і проводів, повинні негайно ліквідовуватися черговим персоналом. 

Пошкоджену електромережу потрібно відключати до приведення її в 

пожежобезпечний стан. 

- на електродвигуни, світильники, інші електричні машини, апарати та 

обладнання, встановлені у вибухонебезпечних або пожежонебезпечних зонах, 

повинні бути нанесені знаки, які вказують на ступінь їхнього захисту згідно з 

чинними стандартами. 

- електропостачання всіх протипожежних пристроїв (пожежних насосів, 

вогнезатримуючих клапанів з електроприводом, централізованої системи 

оповіщення про пожежу, установок охоронно-пожежної сигналізації, 

пожежогасіння, електрозасувок на протипожежних водопроводах, 

сигналізаторів вибухонебезпечних концентрацій горючих газів, 

вибухонебезпечних парів, пилу слід виконувати за першою категорією 

надійності, крім випадків, обумовлених у нормативних документах [11]. 

 

3.2 Заходи першої медичної допомоги при уражені електричним струмом 

 

Для визначення стану необхідно вжити таких заходів: 

- покласти потерпілого спиною на тверду поверхню; 

- перевірити наявність у потерпілого дихання; 

- перевірити наявність у потерпілого пульсу на сонній артерії; 

- з'ясувати стан зіниці, широка зіниця вказує на погіршення 

кровопостачання. 
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У всіх випадках ураження електричним струмом виклик лікаря є 

обов'язковим незалежно від стану потерпілого. 

Якщо потерпілий знаходиться при свідомості, його треба покласти у 

зручне положення і до прибуття лікаря забезпечити спокій, обов'язково 

спостерігаючи задиханням і пульсом. Не можна дозволяти потерпілому 

рухатись, продовжувати роботу. Якщо лікаря швидко викликати не можна, 

необхідно терміново доставити потерпілого у медичний пункт. 

Якщо потерпілий знаходиться у непритомному стані, його необхідно 

покласти, розстебнути одяг, забезпечити приплив свіжого повітря, дати 

понюхати нашатирний спирт, бризнути на нього водою і забезпечити спокій. У 

той же час потрібно викликати лікаря. Якщо потерпілий дихає погано, рідко і 

судомно, йому необхідно робити штучне дихання і непрямий масаж серця. 

У разі відсутності в потерпілого ознак життя не можна вважати його 

померлим. Якщо в такому стані потерпілому не буде надано негайну першу 

допомогу у вигляді штучного дихання і зовнішнього масажу серця, то настане 

смерть. Оживлення організму, ураженого електричним струмом, може бути 

проведено кількома способами. Всі вони базуються на штучному диханні. 

Починати штучне дихання слід негайно після вивільнення потерпілого від 

електричного струму і проводити безперервно до досягнення позитивного 

результату. Штучне дихання необхідно робити безперервно, до прибуття 

лікаря. 

Ураженого електричним струмом можна визнати померлим тільки за 

наявності видимих тяжких зовнішніх ушкоджень: роздроблення черепа у разі 

падіння чи обпалення всього тіла. В інших випадках констатує смерть лише в 

лікарні. 

Для надання якісної медичної допомоги потерпілому оператор який 

використовує метрологічні прилади повинен знати правила допомоги при 

ураженні електричним струмом, та періодично проходити опитування на 

знання першої долікарської допомоги [12]. 
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Висновки 

 

При виконані даної кваліфікаційної роботи було спроектовано електричну 

принципову схему цифрового DDS генератора, розраховано і розроблено 

топологію друкованої плати та складальне креслення друкованого вузла. 

При розробці цифрового DDS генератора пораховано фільтр Баттерворта, 

який відновлює цифровий сигнал в аналоговий. Була проведена робота по 

компонуванні друкованої плати а також компонуванні елементів для якісної 

роботи пристрою. Також був проведений розрахунок друкованого монтажу. 

Проектування друкованого вузла було виконано в програмі Altium 

Designer, за допомогою якої було здійснено компоновка і трасування 

провідників друкованого вузла. В результаті якого було отримано плату 

розміром 111х65мм. 

Було виготовлено чотири креслення для розробки генератора: схема 

структурна, схема електрична принципова, друкована плата, друкований 

вузол. Оформлення креслень було виконано за допомогою програми 

KOMПAC-3D V15.2. 
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